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ASSESSMENT

Bond® 
Blocks Using the Bond Blocks Test

Organisation
The teacher will need:

i.	 A pen to record student responses.

ii.	 One copy of the ‘Bond Blocks Test - Recording Sheet’. Download and print this. Place this in front of the teacher.  

Students view the questions using either:

i.	 The Bond Blocks Test Powerpoint

There are two versions of the Bond Blocks Test PowerPoint. The written questions are identical in both versions 

however the language used to say the subtraction equations are different:

•	 In the version titled “Bond Blocks Test – Using Subtract and Equals” the subtraction questions are read using the 

words “subtract” and “equals”. For example, “Five subtract three equals?” 

•	 In the version titled “Bond Blocks Test – Using Take Away and Is” the subtraction questions are read using the 

words “take away” and “is”. For example, “Five take away three is?”

Use the version that has the language the students you are testing are most familiar with.

 

ii.	 The Bond Blocks Test - Student Viewing Sheet. 

Print one copy of this and place this in front of the student. 

 

Note: This needs to be printed separately from the Test Recording Sheet, not double-sided. Place one piece of 

blank paper on top of the Student Viewing Sheet, under the item currently being read to the student.
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Bond Blocks Test - Student Viewing Sheet
• Place this sheet in front of the student. Use a piece of blank paper to screen items not currently being read to the 

student.

• Read each test item to the student. Use your finger to point to each number and symbol as it is said.

• Students respond verbally. Student responses are recorded by the teacher on the Recording Sheet.

1) , 8, 9

2) 5 - 3 = 
3)  + 2 = 5

4) One half of 6 is 

5) 8 - 5 = 

6)  + 4 = 10

7) 10 - 7 = 

8) 10 -  = 2

9) 6 - 4 = 

10) 7 - 5 = 

11)  + 5 = 8

12)  - 6 = 3

13) 17 - 10 = 

14) 3 +  = 13

15)  - 6 = 10

16) Double 7 is 

17) One half of 16 is 

18) Double 9 is 

19) 13 - 8 = 

20)  - 7 = 8
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Bond Blocks Test - Recording Sheet
Student Name:

 
Class:

Complete During Test Complete After Test

Pre-Test 
Date:

Post Test 1 
Date:

Post Test 2 
Date: Teaching / Learning Focus

fluent

correct, not 
         fluent

incorrect

fluent

correct, not 
         fluent

incorrect

fluent

correct, not 
         fluent

incorrect

Highlight if not 
fluent

Bond 
Blocks 

Chapter

1 ? , 8, 9 Counting 1

2 5 - 3 = ? Bonds of 5 2

3 ?  + 2 = 5 Bonds of 5 2

4 One half of 6 is ? Double 1,2,3,4,5 
related halves 3

5 8 - 5 = ? Five Plus Bonds 4

6 ?  + 4 = 10 Bonds of 10 5

7 10 - 7 = ? Bonds of 10 5

8  10 - ?  = 2 Bonds of 10 5

9 6 - 4 = ? Bonds of 6 6

10 7 - 5 = ? Bonds of 7 6

11 ?  + 5 = 8 Bonds of 8 6

12 ?  - 6 = 3 Bonds of 9 6

13 17 - 10 = ? Ten Plus Bonds 7

14 3 + ?  = 13 Ten Plus Bonds 7

15 ?  - 6 = 10 Ten Plus Bonds 7

16 Double 7 is ? Double 6, 7, 8, 9 
related halves 8

17 One half of 16 is ? Double 6, 7, 8, 9 
related halves 8

18 Double 9 is ? Double 6, 7, 8, 9 
related halves 8

19 13 - 8 = ? Bonds of 11 to 20 9

20 ?  - 7 = 8 Bonds of 11 to 20 9

Recording Sheet Student Viewing Sheet

Bond Blocks Test Powerpoint
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ASSESSMENT

Administering the Test
Teacher Instructions
The test is administered to students one at a time. 

•	 Sit next to the student being tested.

•	 Place the Recording Sheet and pen in front of yourself.

•	 Place the test questions in front of the student. This will be either a device showing the PowerPoint or the Student 

Viewing Sheet. 

•	 Read the first test item to the student. Use your finger to point to each number and symbol as it is said aloud. 

Use terminology for ‘addition’ and ‘subtraction’ familiar to the student. The correct terms will be systematically 

introduced as students progress through the Bond Blocks activities.

Students respond verbally. Record the student’s response on the Recording Sheet using one of these symbols:

The test becomes increasingly difficult.

Tier One Class Teaching
When testing for tier one class teaching STOP testing after three responses that are not correct, fluent responses.  

For example, three  responses or two  responses and one  . 

•	 Doing this will provide enough information to identify the starting point for groups of students and, in the future, 

monitor progress. 

•	 This will take approximately 3 minutes per student. Allocate between 60 to 90 minutes to test a class. 

Tier Two or Three Intervention
When testing students in Year 1 and 2 for intervention, stop after three responses that are not correct, fluent responses. 

These students do not complete the whole test because it contains curriculum that is beyond their year level.

When testing students from Year 3 on for intervention, administer the whole test to identify gaps in their learning.

•	 Testing students who might require intervention takes longer than testing at a tier one level.  

Allow 10 to 15 minutes per student when testing students for intervention.

•	 If students are very young, have maths anxiety or attentional difficulties split the testing into two short sessions. 

Using the Bond Blocks Test 

Correct, fluent response  
Less than 3 seconds.

Incorrect or no response.Correct response but not fluent.  
Strategies greater than 3 

seconds. Includes counting.
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ASSESSMENT

Bond® 
Blocks Entering Results

Enter results in the Bond Blocks Test - Results and Tracking Tool Excel document. 

   2 - Correct, fluent response.

    1 - Correct response but not fluent. Includes counting.

   0 - Incorrect or no response. 

There is a curriculum version 8 and version 9 test excel.
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Excel Tips
Download and save one copy of the file per Year Level.  File > Save As. This will help administration monitor year level 

cohorts. Class teachers can sort data by Column D “Class” to access their student list.

The test is repeated annually. Record the results for each test on a new sheet.

To modify, edit or sort cells in the Excel, unprotect the sheet.  
Home > Cells > Format > Unprotect Sheet.

Entering Results

There are four sheets.

The progress points between sheets will be automatically calculated.

Each Excel sheet needs to be ‘unprotected’ in order to highlight rows and sort. Home > Cells > Format > Unprotect 

Sheet. This will need to be done for each sheet.
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ASSESSMENT

Bond® 
Blocks 

The Excel spreadsheet of test results can be analysed at two levels:

1.	 Student Level

2.	 Cohort Level

Student Level
Reading the horizontal rows provides student-level information. This data can be used to identify students who 

need intervention and extension. It can also be used to form groups of students working at a similar level for both 

intervention and tier one class teaching. Repeating the test anually provides progress data.

Interpreting Progress: Tier One Teaching
Calculating Progress Points:

Each question on the Test Excel Spreadsheet is allocated to the relevant year level curriculum and is worth a 

maximum of two points. After entering the student responses to each question, the total the number of points that 

relate to that year will be calculated.

Interpreting Progress

To interpret how much progress a student has made compare: 

•	 the number of progress points the student made to

•	 the total number of test points related to the curriculum for that year level.

For example, if a student made 8 points of progress and the maximum number of points on the test for the specified 

year level was 8, this would equate to approximately one year of curriculum as represented by the test.

Student Level

Analysing the Test Results
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Interpreting Progress: Intervention
When interpreting progress for intervention students compare:

•	 the number of progress points the student made between annual tests to

•	 the total number of test points related to the Bond Block chapters they have covered.

For example, if a student had covered Chapters 6 and 7, these chapters have 7 test questions which is a maximum of 

14 points. The student’s test score should be interpreted in light of 14 points. 

•	 A score of 12 for a tier two student would be considered excellent. 

•	 A score of 7 points for a tier three student could also be considered as excellent progress because of the number 

of ‘missing number’ questions in these chapters.

Student progress needs to be interpreted considering their neurological profile.

Please refer to the Tier Two and Three Implementation Support Book pages 15 to 19 that outlines how intervention is 

differentiated.

Case Study
The following data was collected from a 

West Australian school. These Year 1 students 

participated in Bond Blocks as intervention only. 

They completed Chapters 2, 3 and 4. 

The total number of test points covered by 

these four test questions, is 8 points. Each 

students’ progress points is compared to 8.

Concerning lack of progress.

Accounted for, reduced progress.

Excellent progress

Student
Pre-Test  

March 2021
Post Test 1  

November 2021
Progress 

Points

Student 1 2 4 2

Student 2 2 4 2

Student 3 2 7 5

Student 4 2 10 8

Student 5 0 8 8

Student 6 2 11 9

Student 7 2 14 12

Analysing the Test Results
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Cohort Level
Reading the vertical columns provides cohort-level information. Columns where most of the students experienced 

difficulty show gaps in teaching/learning. This is often apparent in the content area of missing number equations.  

The example below highlights subtraction test questions where the missing number is in the whole position.

Compared to the eight points of curriculum covered by the test:

•	 Students 4, 5, 6 and 7 (green) made excellent progress of eight points or more. Two of these students applied 

knowledge from the chapters covered to correctly answer questions from later chapters earning more progress 

points than the eight covered by the four test questions related to the chapters of activities completed.

•	 Student 3 (yellow) made less progress in comparison, but this was still pleasing. This student has a diagnosis that 

accounts for this.

•	 Students 1 and 2 (red) made very little progress. The class teacher had a range of concerns about these Year One 

students. These students were also participating in a literacy intervention program and had made a concerning 

lack of progress in this area. The Bond Block data added to the evidence that was presented to the principal and 

parents which led to investigation by medical and allied health professionals.

Another frequent example identified by schools when analysing cohort data is a difference in results between 

doubling and related halving. Schools often find students are fluent in doubling (for example, questions 16 and 18) but 

not halving (for example, questions 4 and 17).

Analysing the Test Results
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Mathematical Concepts Covered by Each Bond Block Activity

Activity 
Chapter

Bonds Fluency Addition Subtraction Equation 
Building

Missing 
Number 

Equations

Word 
Problems

Calculating 
Strategies

2) Bonds of 5 6 7, 8, 9 10 11 12 13 14, 15

3) Doubling 
and Halving 
to 10

16 17, 18 19, 20

4) Five Plus 
Bonds 21, 22 23 24 25

5) Bonds of 10 26 27, 28 29 30 31 32 33

6) Bonds of  
6, 7, 8, 9 34 36, 37 35 38 39 40

7) Ten Plus 
Bonds 41, 42, 43 44, 45, 47 48 (Set A) 46 48 (Set B), 

49

50, 51, 52,  
53, 54, 55, 

56

8) Doubling 
and Halving 
to 20

57 58, 59, 60, 61 62, 63

9) Bonds of 11 
to 20 64 65 66 67 68 69, 70, 71

Teacher 
Notes

Using Part-Part-Whole:  
Desk Visuals Building Equations: Using Part-Part Whole

Solving 
Missing 
Number 

Equations

Solving 
Word 

Problems

Solving 
Subtraction 

using Taking 
Away or 

Adding On

Numbers represent activity board numbers.

Once these content areas are identified use the ‘Mathematical Concepts Covered by Each Bond Block Activity’ table 

to find activity numbers related to those topics. Complete these activities with the cohort. 

Analysing the Test Results

The table is particularly helpful when using Bond Blocks at a whole school level. Schools new to Bond Blocks often test 

the whole cohort of students, for example Year 4 students. Doing so helps to identify (i) those who need intervention 

and (ii) cohort gaps in teaching/learning.
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ASSESSMENT

Bond® 
Blocks 

After the test the teacher uses a highlighter marker on the Recording Sheet to highlight the Teaching/Learning Foci 

column next to every response tested that was not a ‘correct fluent response’. 

If the student counted correctly to solve the test item they still need to complete the relevant chapter. The goal is 

correct, fluent responses.

Tier Level Instructions
The teacher sets activities for the student from the relevant Bond Block chapter. 

•	 For tier one whole class teaching the results will indicate the starting chapter. Students will then progress through 

all the chapters in order. 

•	 For tier two and three intervention students will progress through the activities in order but only complete the 

chapters of activities they did not give a ‘correct, fluent response’ (recorded with a tick). 

The first time students use Bond Blocks they should always engage in the Exploratory Play Activity, outlined in the 

Implementation section of the Bond Blocks website. During this activity students develop familiarity with the different 

blocks and learn the correct language for the different types of blocks.

Student Reflection and Goal Setting
Students use their test results to set learning goals using the ‘Bond 

Blocks Test - Student Reflection and Goal Setting’ sheet.

Identifying the Teaching Focus

Student Reflection 
and Goal Setting

Students need to complete the whole chapter of activities 

for every response that was not a ‘correct fluent response’. 

For example, there are three test questions for the Bonds of 10 

chapter. If a student answered two of the questions with correct 

fluent responses and one question with a correct response but 

not fluent (counted or took greater than 3 seconds, recorded 

with a C), they still have to complete the whole Bonds of 10 

chapter. This is because the questions are representative of 

typical difficulties. 

Please use teacher judgement when interpreting the test results. 

For example, if a student answered Question 1 incorrectly but the 

next three questions correctly, the error would mostly likely be 

caused by the student settling into the testing, rather than a lack 

of knowledge in the counting sequence. Confirm this in a later 

session by asking similar questions to Question 1. 

Note: Fluent responses are not an appropriate goal for students 

with diagnosed memory difficulties. Correct response is the 

appropriate goal for these students.
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Bond Blocks Test - Recording Sheet
Student Name:

 
Class:

Complete During Test Complete After Test

Pre-Test 
Date:

Post Test 1 
Date:

Post Test 2 
Date: Teaching / Learning Focus

fluent

correct, not 
         fluent

incorrect

fluent

correct, not 
         fluent

incorrect

fluent

correct, not 
         fluent

incorrect

Highlight if not 
fluent

Bond 
Blocks 

Chapter

1 ? , 8, 9 Counting 1

2 5 - 3 = ? Bonds of 5 2

3 ?  + 2 = 5 Bonds of 5 2

4 One half of 6 is ? Double 1,2,3,4,5 
related halves 3

5 8 - 5 = ? Five Plus Bonds 4

6 ?  + 4 = 10 Bonds of 10 5

7 10 - 7 = ? Bonds of 10 5

8  10 - ?  = 2 Bonds of 10 5

9 6 - 4 = ? Bonds of 6 6

10 7 - 5 = ? Bonds of 7 6

11 ?  + 5 = 8 Bonds of 8 6

12 ?  - 6 = 3 Bonds of 9 6

13 17 - 10 = ? Ten Plus Bonds 7

14 3 + ?  = 13 Ten Plus Bonds 7

15 ?  - 6 = 10 Ten Plus Bonds 7

16 Double 7 is ? Double 6, 7, 8, 9 
related halves 8

17 One half of 16 is ? Double 6, 7, 8, 9 
related halves 8

18 Double 9 is ? Double 6, 7, 8, 9 
related halves 8

19 13 - 8 = ? Bonds of 11 to 20 9

20 ?  - 7 = 8 Bonds of 11 to 20 9

Test Item

Related teaching and 
learning focus.

Recording for Pre-Test, Post 
Test 1 and Post Test 2.
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ASSESSMENT

Bond® 
Blocks Monitoring Progress

For teachers who prefer to use physical recording methods, progress can be monitored and observations recorded 

using the Recording Sheets. There are three levels of recording sheets:

1.	 Monitoring Sheet for an Individual Student (Tier 3 Intervention) 

This is used for tier three intervention and can be attached to students’ individual education plans. 

2.	 Monitoring Sheet for Six Students (Tier 2 Intervention) 

This is used for tier two intervention. It can also be used during differentiated tier one instruction for small groups 

of students working at a different level to the majority of the class (above or below).

3.	 Monitoring Sheet for a Class (Tier 1 Teaching) 

This is used a tier one level to monitor which students have completed which activities.

These recording sheets can be downloaded from the Assessment and Monitoring section of the website.  

They are available in a paper (PDF) and electronic (Excel) versions.

Individual Student Six Student Whole Class
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Bond® 
Blocks Retesting

Retesting: Tier One
At a tier one level the Bond Blocks Test is administered three times:

•	 Start of Year One.

•	 End of Year One.

•	 End of Year Two.

Each time the results are recorded on a separate sheet in the Bond 

Block Test Excel Results and Tracking Tool.

The test is administered one-to-one and takes approximately 3 

minutes per student. Stop testing after three responses that are not 

correct, fluent responses. The test becomes increasingly difficult. 

Doing this will provide enough information to identify the starting 

point for groups of students and, in the future, monitor progress. 

Allocate between 60 to 90 minutes to test a class. 

For specific test administration instructions see the ‘Administering the Bond Blocks Test Instructions’ in the Bond 

Blocks Assessment Support Book.

1.	 Pre-Test 

Administer the test to each student for the first time at the beginning of Year One, once the students have settled 

in. The test is given before the students start any Bond Block Core Activities. 

2.	 Post-Test 1 

Readminister the test at the end of Year One to identify progress. 

3.	 Post-Test 2 

The test will not need to be readministered at the start of Year Two. Instead the data from the end of Year One 

test will be used.  

Readminister the test for a third time at the end of Year Two.

Retesting: Intervention 
1.	 Pre-Test 

Administer the test when students commence Bond Blocks, prior to the completion of any activities. This will 

establish a baseline. This often occurs in schools during March once students are settled.

2.	 Post-Test 1 

Readminister the test at the end of the year.

3.	 Post-Test 2 

Readminister the test at the end of the following year.

Please note, some Tier Three students do not respond well to tests and give responses that are not indicative of their 

actual achievement. For these students, use the observations recoreded on the Tier Three “Monitoring Sheet for an 

Individual Student” as a valid measure of their progress.
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Bond Blocks Test - Recording Sheet

Student Name:

 
Class:

Complete During Test Complete After Test

fluent correct,  
not fluent incorrect Teaching / Learning

Pre-Test 

Date:

Post Test 1 

Date:

Post Test 2 

Date:

Post Test 3 

Date:
Highlight if not fluent

Bond 
Blocks 

Chapter

1 ? , 8, 9 Counting 1

2 5 - 3 = ? Bonds of 5 2

3 ?  + 2 = 5 Bonds of 5 2

4 One half of 6 is ? Double 1,2,3,4,5 
related halves 3

5 8 - 5 = ? Five Plus Bonds 4

6 ?  + 4 = 10 Bonds of 10 5

7 10 - 7 = ? Bonds of 10 5

8  10 - ?  = 2 Bonds of 10 5

9 6 - 4 = ? Bonds of 6 6

10 7 - 5 = ? Bonds of 7 6

11 ?  + 5 = 8 Bonds of 8 6

12 ?  - 6 = 3 Bonds of 9 6

13 3 + ?  = 13 Ten Plus Bonds 7

14 ?  - 6 = 10 Ten Plus Bonds 7

15 14 - 8 = ? Ten Plus Bonds 7

16 Double 7 is ? Double 6, 7, 8, 9 
related halves 8

17 One half of 16 is ? Double 6, 7, 8, 9 
related halves 8

18 Double 9 is ? Double 6, 7, 8, 9 
related halves 8

19 13 - 8 = ? Bonds of 11 to 20 9

20 ?  - 7 = 8 Bonds of 11 to 20 9

Bond Blocks Test - Recording Sheet
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Bond Blocks Test - Student Viewing Sheet
•	 Place this sheet in front of the student. Screen items not being read using a piece of blank paper.

Read instructions in these boxes to the student before showing the adjacent question. 

•	 Read each test item to the student. Use your finger to point to each number and symbol as it is said.

•	 Students respond verbally. Student responses are recorded by the teacher on the Recording Sheet.

1)  , 8, 9

2) 5 - 3 = 
3)  + 2 = 5

4) One half of 6 is 

5) 8 - 5 = 

6)  + 4 = 10

7) 10 - 7 = 

8) 10 -  = 2

9) 6 - 4 = 

10) 7 - 5 = 

11)  + 5 = 8

12)  - 6 = 3

13) 3 +  = 13

14)  - 6 = 10

15) 14 - 8 = 

16) Double 7 is 

17) One half of 16 is 

18) Double 9 is 

19) 13 - 8 = 

20)  - 7 = 8

Bond Blocks Test - Student Viewing Sheet

“When counting, what number goes here?” 
“Something (Point to the missing number box), eight, nine.”

“For the rest of the questions tell me what number goes in the 
missing number box.”
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Bond Block Test - Student Reflection and Goal Setting

Name:							           Date:

Circle how you feel after your test: 

I feel like this because: 

Tick what you need to focus on:

My goal is to:

Teacher comment:

Parent comment to their child:

Counting 

Bonds of 5

Double 1, 2, 3, 4, 5 and related halves

Five Plus Bonds

Bonds of 10

Bonds of 6, 7, 8, or 9

Ten Plus Bonds

Double 6, 7, 8, 9, 10 and related halves

Bonds of 11 to 20

Bond Blocks Test - Student Reflection and Goal Setting
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